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Welcome to Allianz Life!

We're excited to welcome you and offer you an experience designed to help enrich the future of your
career. This guide provides instructions on how you will set up your technology to access our secure
systems. Please work through these instructions in preparation for your first day at Allianz Life!

Technology set-up: Set up your access to the Allianz Life systems so you're
ready to hit the ground running on day one.

Orientation: Your first day will begin with a New Employee Welcome (NEW)
session via WebEx. Remember to sign in at least 5 minutes prior to the start
of the session to ensure you are on time, can hear sound and see what’s
being displayed.

¢ Make sure you have a webcam so that people can see you.

e Using a headset is recommended (not the built-in speakers), so
people can hear you clearly and to avoid “feedback” from disrupting
the meeting.

¢ Always mute when you’re not speaking

e Review these Quick Tips from Webex to maximize the program’s
effectiveness.

Payroll: Set up your ADP ESS account and learn how to record your
time.

You'll receive separate instructions on how to register for your ADP ESS
account, set up direct deposit and record your time. You can’t do this until you
your first week of work as you need to wait for an email with a registration
code. We’re highlighting it here because these steps are critical to ensure
your payroll is processed accurately and on time.

IMPORTANT: If you received equipment from Allianz Life, keep the shipping boxes and the enclosed return
labels.
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Here’s what you need to get started
Checklist for setting up your systems
Setting up your RSA Token
A. Downloading the RSA Token App
B. Receiving your RSA Token QR Code and Activation Code
C. Installing the RSA Token app on your mobile device
E. Setting your Token PIN
ACCESS OPTION ONE: CITRIX for Personal PC/Laptop
ACCESS OPTION ONE: CITRIX for Mac Computers
ACCESS OPTION TWO: Access an Allianz workstation remotely
ACCESS OPTION THREE: Setting up Allianz Wyse Terminal

ACCESS OPTION FOUR: VDI Access
Launch the VDI
VDI Tips and Tricks
When to restart
Setting up VPN for your AZL Device (Applicable to Laptop Users)

How to Disconnect from the VPN
Setting up Outlook

Your email address

Outlook Resources

Create an Outlook Signature

Add your photo to Outlook
Allianz Global Certificate Setup
Learning: AllianzU powered by Degreed
Teleconferencing

Using a Conference Bridge

Tips for using Webex

Setting up Webex
Requesting access to additional programs
Troubleshooting network capacity

Tips for working from home
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Your leader will be setting up time to call you with the following log-in information. If you do not hear from
your leader, please reach out to them.

Your Network ID (AZL #):

One-time Network password:

One-time RSA Activation Code*:

Your Allianz Life email address:

Access Option** (Citrix, Remote workstation or VDI):

*You’ll need to initiate the RSA Token process on page 5 prior to your start date your leader will receive this
code by email.

**The way you'll access our secure systems is based on the work you’ll be doing and the applications you’ll
need to do that work. Talk to your manager to determine which access option they have requested for you.
If your manager does not know, call the Service Desk at 763.765.6181.

IMPORTANT: For security purposes, do not write down any of your custom passwords (those you
use after the one-time password).

Follow the instructions on the following pages to complete these action items. If you run into
technical issues, call the Allianz Life Service Desk for support at 763.765.6181.

O Install your RSA Token

O Setup your access option to connect to the Allianz network

00 Set up your Allianz Outlook account (email)

O Request/download your Global (SSO) Certificate

[0 Check with your manager on accessing your team’s network drive(s), additional applications, and
applicable SharePoint sites

O Access your Webex account (if you have one — check with your manager) and set your photo and

other preferences

O Register for ADP ESS (our timecard/payroll system) on Thurs/Friday of your first week to set up
your direct deposit and learn how to enter your hours worked so you are paid accurately and on
time. (Directions for these steps will be provided separately).

O After your first week, log into AllianzU and Degreed to begin your required training.
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Setting up your RSA token
Set up your RSA token on your mobile device

Note: The screen captures provided in this article pertain to Android. However, the installation steps are the
same for iPhone & Android devices.

This article will walk you through:
A. Downloading the RSA token application
B. Receiving your RSA token QR code and activation code
C. Installing the token on your mobile device
D. Setting a token PIN

A. Downloading the RSA token app

If you have an iPhone, use the App store; for an Android device use the Google play store. Search for
keyword “SecurelD”, the application is published by “RSA Security”

What's new

Rate this app

Developer contact

Join the beta

B. Receiving your RSA token QR code and activation code
1. Once the request is submitted, set-up instructions (including an activation code and a QR code) will be
sent to your manager via email from the Allianz Life Service Desk team.
2. To set-up your token, you will need
a. aone-time activation code unique to you.
b. a QR code. The QR code is specific to your phone type (iPhone, Android or Windows).

Both of these will be included in the email instructions sent to your manager. Your manager will relay your
activation code to you over the phone, but will send you the QR code to your personal email.
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C. Installing the RSA Token app on your mobile device.

e Open the app and accept the license agreement, if prompted.
e Select the plus sign in the upper right.

L & securlD ‘+/
Then the ability to scan the QR code to enter a URL will appear

e Accept the usage of your phone camera if prompted.
e Scan the QR code provided by the Service Desk via email.
¢ When prompted, enter the one time activation code provided by your manager.

E. Setting your Token PIN

@ Navigate to this website on any computer or mobile device:
S https://src-eul.allianz.com/pin
Allianz

Welcome to
Token validation/verification page for N¢

e Enter your AZL ID in the Username field
o Enter the current 6 digit token code from the RSA app on
your mobile device into the Tokencode field. Click Sign-in.

Username [AZL6TIA i If this is your fir
enter your token

Tokencode [ and to re-authen
If'you'v.e already
‘S'QT"“ zggexg?lud. Please
Entergonlythe,six.digits
from the| RSAapp:

Allianz e You will be prompted to create a new PIN.
g The PIN must be 4-8 digits long, cannot start
Token validation/verification page for North American users with 0, cannot be anything trivial like 1234,

P New PIN Required 7777, etc. and cannot be any PIN you have

You must create a new Personal Identification Number (PIN) before you can sign in. Your PIN should be 4 to 8 digits long.

Confirm PIN:

used previously with RSA.

* Besureto

¢ You will return to the username and
tokencode page with a notice saying “your
new PIN has been saved. To continue
logging in, please wait for the code on your
SecurlD token to change and then enter

welcome to your NEW PIN followed by the SecurlD

Token validation/verification page for North American users token code

Save PIN || Cancel

Your new PIN has been saved. Be sure to remember your PIN, because you need it each time you sign in. To continue logging in, please
wait for the code on your SecurlD token to change and then enter your NEW PIN followed by the SecurlD token code.

Username E If this is your first visit, please enter your username associated with your token and then,

enter your token code (see the 6 digits of your token). You will then be asked to enter a PIN
Takanrada v e T i T .
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Refer to the notes you took during your manager call to understand which access option you have
and follow the instructions for that option.

ACCESS OPTION ONE: CITRIX for Personal PC/Laptop

The portal is an internet web page accessible by most browsers (i.e. Chrome, Safari). You may need to install
a Citrix component the first time. Reboot your computer when you use this program for the first time.

Prerequisites:

1. APC, Apple, or other device running a common internet browser connected to the internet.
2. The ability to permit installation of updates that may depend on Citrix, if needed.
3. Your AZL ID, and network password.
4. Your RSA token, including your Pin.
5. The URL shown below.
1. Enter this URL into your Internet Browser: https://avc-na.allianz.com/vpn/index.html.
2. Enter your credentials as shown below and check the | accept box, if prompted.
a. User name: enter AZL6XXX ID.
b. Passcode: enter RSA Pin + RSA Passcode from app.
c. Password: enter Network Password.
d. Click Log On
Welcome to Allianz Virtual Client. Please Icg
on to continue.
3. Firsttime access on the personal computer will be prompted to install the Citrix Receiver.
a. Click Allow and/or Agree on any Security Windows that open.
b. Click Run, Install, Download, Allow, and/or Agree as needed on any Citrix Installation
windows that open.
4. The Portal should now be open (see below).
Allianz @) a. B
Detaik \/J Details G Detail /J Detail
— Detail it Detail ~ Detail ‘E Detail
a. If nothing appears, go to: https:/avc-na.allianz.com/vpn/index.html
b. Click Already Installed on the Download Window.
5. Each application shown will run individually after clicked — start those which you need.
a. Network drives should show up within applications normally for Open and Save As functions.
6. Browse network drives by opening the Windows Explorer application.
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ACCESS OPTION ONE: CITRIX for Mac Computers

1. Download the Citrix receiver for Macs here: https://www.citrix.com/downloads/citrix-
receiver/mac/receiver-for-mac-latest.htmi
2. Navigate to the AVC — avc-nal.allianz.com
3. Type in your network ID, network password, and then your 4 digit pin and RSA token number in the
passcode. Pick one of the below options.
i. Avcpci-portal-nal
ii. Avc-portal-nal
iii. Avc-ffic
4. You will be brought to the home page and can open an app.
5. When you click, the app will be downloaded in your Downloads folder. You should be able to right click
and always open files of that type so you don’t have to always go there to open it.
Page |8 For technical support, call the Service Desk at 763.765.6181.
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Note: This access option enables you to connect to an Allianz Life laptop or PC from your location. Not
everyone will have this remote application available on their portal.

Prerequisites:

1. A company PC or laptop at Allianz Life running (turned on) and connected to our network.
2. Access rights for Remote Desktop capability requested and approved from Service Now.
3. APC, Apple, or other device running a common internet browser connected to the internet.
4. The ability to permit installation of updates that may depend on Citrix, if needed.
5. Your AZL ID, and network password.
6. Your RSA token code, including your PIN.
7. The Portal Address URL shown below.
8. The name of your Company laptop or PC (i.e., Z1X2ABCDEFG).
Steps:
1. To access the portal, enter the following URL into your Internet Browser: (https://avc-
na.allianz.com/vpn/index.html
a. Inthe Portal, click on the Remote Desktop Icon (not Remote Desktop Console)
Z7-MJYCDFEHD ZXDMJO8PI3V
NOTE: Frist time users will see this.
L-;< Details a-. Details
Remote Desktop Remote Desktop Console
2. Enter your AZL ID, Network Password, and Computer Name. Click Log in.
a. Your computer name is typically labeled on your Allianz computer and usually starts with a Z.
3. How to find your Work PC/Laptop Name.
a. You must know the PC/Laptop name before you try access remotely. The manager or
Service Desk will be able to tell you this information.
b. Go to your Windows Icon/Start Menu, right-click and then Select System.
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ACCESS OPTION THREE: Setting up Allianz Wyse Terminal
Equipment set up

Monitors
For a step-by-step video to help with your monitor set-up: https://bit.ly/2yzyCnp

1. Remove all parts from the box. We recommend setting up one monitor at
atime.

2. Attach the rectangular pole to the square base by lining up the holes on
the base with the screws on the pole and twisting to the right to tighten.

3. Snap the monitor to the newly created base by lining up the back of the
monitor with the back of the base.

4. Plug the monitor into a power outlet.

5. Use the provided cable to connect the monitor to the Wyse terminal. (see
image)

6. Repeat steps 1-5 for the second monitor.

Wyse terminal
The Wyse terminal is the “brain” of your work from home set-up.

Attach the three prongs to the base and slide into place. (see image)
Connect the mouse and keyboard through the USB port. (see image)
Connect the two monitors to the display ports. (see image)

Insert one end of the Ethernet cable into the network port and the other
end into your router. (see image)

Insert the power cable into the power port. (see image)

Power on your Wyse terminal.

PoONPE

oo
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Wyse terminal log on

Your log on screen should automatically prompt you to enter your log on information after powering on the
terminal. If not, check the cables and internet connection.

Username: AZLBXxX

Password: Network password

Passcode: PIN + RSA token number

The list of applications is available in a menu on the left side. Hover the cursor for 3-5 seconds on the far left
side of the screen to make the menu pop up.
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ACCESS OPTION FOUR: VDI Access

Go to https://www.citrix.com/products/receiver/ to install Citrix Receiver 4.5 or above. A Citrix Receiver
Account is not needed. Once installed, simply close the window and follow the steps below.

1. Use this link to log into the VDI from outside the Allianz Global Network: (https://avc-
na.allianz.com/vpn/index.html
2. To install Citrix Receiver, click | agree and then click Install.

4. Inthe User name field, enter your AZL ID provided by your manager.

5. Inthe Passcode field, enter your four-digit PIN followed by the 6-digit number displayed on the RSA
app you downloaded to your phone. Do not enter any spaces between your PIN and the token
numbers.

6. Inthe Password field, enter your network password.

7. Click Log On.

User name:

Passcode

Password:

Launch the VDI
1. Click DESKTOPS to see the VDI Desktop.

Allianz @ s | e | 2

2. Click on your VDI to launch it.

- Details - Details

AVC - W10 NAL - ZA711- AVC - W7 NAL - ZXVO05F8AFD
XD20009
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VDI Tips and Tricks
Remember: Sign out every day

/Qo Change account settings

B ok Signing out saves and closes the VDI session. Please save all data to a network drive
before signing out. Signing out should be done at the end of each day.

[:* Sign out

o o Click Start, and click the person icon in the start menu.
B e Click Sign out.

- AppSense Applicatid

c If you have not saved your data, you may lose work if the system signs you out or
E Calculator disconneCtS you-

Calendar

£ Type here to searcl

When to disconnect

Disconnecting puts the VDI session in stand-by. All programs remain running but data isn’t
automatically saved. After a certain duration of inactivity, the VDI will be restarted, and data which
hasn’t been saved will be lost. Save all documents before disconnecting.

1. Open the taskbar by clicking on the arrow in the upper area of the screen.

2. Click Disconnect from the Taskbar.

(5] = s Hs

Home Ctrl+Alt+Del ef = Disconnect Shortcuts

3. A Desktop Viewer message will display, check Disconnect.

When to restart

A restart should only be used if a VDI stops responding or cannot be accessed in a timely manner (within 5
minutes).

1. Go to the Desktops tab, click Details.

Allianz ()
=
AVC - W7 NA1 WP1 - ZAZ11
D10060
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2. Click Restart.

Allianz ()
<

— AVC - W7 NA1 WP1 - ZAZL1-D10060
Open |1 Restart ] R Add To Favorites ]

3. When asked if you want to restart, click Restart. Wait 5 minutes before restarting your VDI
again.

What’s on your VDI taskbar
Your taskbar is located at the top of your VDI desktop

Access the taskbar by clicking on the arrow in the upper area of the screen.

The following functions are available on this taskbar. Please note that you have to click on the Ctrl-Alt-
Del button to lock and unlock your VDI. Using the keyboard locks and unlocks your actual
workstation (not the VDI).

L 4 L1
HE -

Disconnect Shortcuts

Home - Returns to Desktop or Laptop

Ctrl+Alt+Del - Locks and unlocks VDI

Preferences - Do Not Use

Full Screen - Toggles between window view and full-screen view
Disconnect - Puts VDI in stand-by

Shortcuts - Preset shortcuts

~oooow
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Full screen toggle
To toggle between a re-sizeable window screen and a full-screen display:

1. Open the taskbar by clicking on the arrow in the upper area of the screen.

2. Click Full Screen from the taskbar.

Disconnect Shortcuts

Switch between VDI and the Desktop or Laptop

1. Open the taskbar by clicking on the arrow in the upper area of the screen.

2. Click Home on the taskbar to take you to your desktop screen.
M| = % DO P H

Home Ctrl+Alt+Del Preferences Full-screen Disconnect Shortcuts

3. To reactivate the VDI, click the VDI icon in the windows taskbar.

7 W B Fglabafhary

Data Storage
Always use the H: Drive, a shared drive, SharePoint, or OnBase to save files. Never store data on the VDI.

Optional: MS Office default file location

To use a network drive as the default storage location within the MS Office tools. Repeat these steps in
each Office application.

1. Open the File tab at the top left corner of the page.
2. Select Options.
gaTm

e et Pege Layout Focemulas Data
Information about Bookl

Permissions

Anyone can open, copy. and change any part of this workbook

Prepare for Sharing

Before ghaning this fle, be aware that it contains

fersions
2 ] There ate ne previous venions of this File
iy
Versicns -
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3. Select Save, enter the exact path for the default file location. (Example: “H:\")

e O e . e

‘ [ Il customie how workbooks ace saved.

Formulas
Froofing Save workbooks

Save files in this format:  Excel Workbook [~
Langusge [¥) Save dutoRecover Information every |10 |+ minutes
b o V] Keep the last autosaved version if 1 close without saving
Advance

AUtOBeCowr file OCation: | CASrS AZIEXMUVAPPDMA\R0IMING M 050 Excer,
EOROMEN R [oersutt tie rocation: C\Users AZLEYML Documents |
Quick Access Tocibar

AutoRecover exceptions for: ] Books ]

Add.Ins ua

Disable AutoRecover for this workbook only
Trust Center

Officse editing options for document management sesves fes

Save checked-out files to:
The server drafts [ocation on this computer
& The Office Document Cache

Serger deafts locations | C\Users\AZLEXML\Documents\SharePomnt Drafts\
Preserve visual appearance of the workbook

Choose what colors will be seen in prewious versions of Excet Lolors... |
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Setting up VPN for your AZL Device (Applicable to Laptop Users)

Welcome to Check Point VPNI!

Check Point Mobile VPN is used to remotely access Allianz Life internal networks and systems. The application
is only available on all Allianz corporate managed laptops. It is not available on desktop computers or mobile
devices like smartphones and tablets.

How to Connect to VPN

1. Open the Taskbar Notification Area (near the time and date section)

3. Click Connect To...

The Logon window will appear for you to enter your credentials:

& Teul - =] x

Site: Allianz VPN US 2 -

Gateway: phoe-ras-20 hd

Authentication

Please enter your credentials:

Username: I |

PIN: I |

Tokencode: I |

Connect Cancel Help

Selected Login Option: Standard Change Login Option Settings

Username: AZL6 ID
PIN: RSA PIN (the pin that you created and memorized)
Passcode: Passcode (the rotating 6 digits on the mobile device or FOB)

Click Connect button (Note-icon stays grayed out until username and password fields are populated)
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How to Disconnect From the VPN:

1. Open the Taskbar Notification Area

2. Right-click the Check Point lock icon

Disconnect

VPN Opticns

Help L4

Show Client
Shutdown Client

3. Click Disconnect

Disconnect

VI tions
Help L4

Show Client
Shutdown Client

4. Click Yes if you are sure you want to disconnect

= Check Point Mobile %

Are you sure you want to disconnect?
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To Validate you are connected to the VPN

1. Open the Taskbar Notification Area

L. E3ITPM
A G § ) S Eﬁ

2. Find the Check Point lock icon

If you are connected, you will see a green dot on the lower right side of the pad lock icon.
If you are having issues, try these simple troubleshooting tips:

e Make sure the computer is connected to the internet (WIFI or Ethernet/LAN Cable) and
verify access to external sites (Example: CNN.com)
¢ Make sure you are typing your Network ID (AZL ID), RSA PIN, & RSA passcode correctly

e Try selecting the other VPN Gateway in Gateway drop down menu. For example, try
selecting the option that starts with Edi site instead of Phoe

If you continue to have issues, please contact the Allianz Life Service Desk at x46181, 763-765-6181
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Identifying your email address
Your email address is displayed in the blue bar located at the top of your Outlook window after you launch
Outlook.

Outlook Resources
Once you are logged in to our systems, view this Outlook support SharePoint site to help you with customizing
settings and provide answers to frequently asked questions about Outlook.

Please add your signature and photo to outlook using these instructions:

Create an Outlook Signature

1.

N

Click the Signature Templates for Outlook link on the Qutlook SharePoint page. It is listed in the menu
on the left side of the page. You can also click here and it will download to your computer.

Open the downloaded file and copy the appropriate template based on your role.

Follow these instructions: Setting up your Outlook Signature. Do not change the font size, color or
add any other elements to the signature.

Add your photo to Outlook
As a result of working virtual, we're asking all employees to add a personal photo to their Outlook and Webex
accounts. To add your photo to Outlook, follow these instructions:

1.

2
3.
4.
5

o

Open Outlook and select File from the top menu.

In the Account Settings section, select Change below the square photo icon.

When you click Change, you'll be prompted to log into Outlook Web App (OWA).

For your user ID, add AZLIFEM\ before your user ID. All employees should use this domain.

If your login page auto-populates with your domain and user ID, check to ensure the domain displays as
above.

Your password will be the same as the one you use to log into your computer.

Once logged in, upload a photo of yourself and click Save. You may not notice any changes after
clicking Save.

NOTE: After following these instructions, wait 24 hours for the system to display your image. It will
not appear immediately.
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Allianz Global Certificate Setup

Once you have logged in to the network and have access to your Outlook email, install your Global
Certificate (aka Single Sign On SSO Certificate). This certificate is required to access many systems.

The Allianz Global Certificate is one of the key items you need to access many of the secure portals available
to employees, including MyHR, which is where you’ll go to access our recognition and timecard tools, etc.
Please follow these steps to set up your certificate and call the Service Desk at 763.765.6181 if you need
support.

Setting up the Certificate
1. Browse to certificate download link: https://userca.allianz.de.awin
The certificate download link only works with Edge. It will not work with Google Chrome.

2. Enter your Allianz Life email address (this is displayed at the top of your Outlook window), then click
Suchen.
IMPORTANT: Although the screen you see says you can enter your ID or your email address; enter your
Allianz Life email address and press Suchen.

Allianz @)

User Certificate Request Interface

Authentication

Your identity could not be determined automatically.

In order to issue a certificate, your entry in the Allianz Group Directory has to be found and its E-Mail address has to be verified.

Please enter for the first step (searching your entry in the Group Directory) your userid (e.g. G1234 or T123456) or your corporate e-mailaddress (e.g. givenname.surname@allianz.com) and hit
Enter.

UserId or E-Mailaddress ‘ |m

3. Enter the characters in the Captcha image and click on Get PIN. To refresh the Captcha image, click on it.

Allianz ()

% ‘. User Certificate Request Interface

Authentication

Your identity could not be determined automatically.

In order to issue a certificate, your entry in the Allianz Group Directory has to be found and its E-Mail address has to be verified.

Your entry in GD is:
Allianz Technology of America, 763765 i @allianzlife.com

mSnm7bg

Enter Captcha above :

4. An auto generated PN and the corresponding TAN will be sent to your Allianz Life email address.
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Allianz () &
.. User Certificate Request Interface

Authentication

Your identity could not be determined automatically.

In order to issue a certificate, your entry in the Allianz Group Directory has to be found and its E-Mail address has to be verified.

Your entry in GD is:
Allianz Technology of America, 763765 , @allianzlife.com

AN4R 5% ™

L-\l..l HUTH

Enter Captcha abave

4depgfs

To verify the e-mai address dale.crosby@allianzlife.com a signed mail, containing a transaction number (TAN) has been sent.

You can enter that TAN from the mail here, OR you can enter your personal identification number on the intranet page that is linked in the mail.
This PIN/TAN pair is usable only once!

Your PI is: = a1
The TAN from your Mail is: | Absenden |

| 5. Enterthe TAN sent to your
email and click on Absenden.

Allianz @)

User Certificate Request Interface

You have been authenticated as
Name:

E-Mail: @allianzlife.com

Initialising Plugin

6. The authenticated Name and
E-Mail address is displayed.
Click on the Request certificate
button to download certificates.

7. A plugin is used to download
the certificates.

Allianz @

You have been authenticated as
Name:

E-Mail: @allianzlife.com

request certificate

User Certificate Request Interface

8. Successful installation of
certificate.

9. Your authentication data will
then be confirmed and you can
install the certificate by pressing
the request certificate button

Allianz @

Webauthentication Configuration

Certificate selection has been completed successfully.

Your new software certificate has been selected for authentication

This success page indicates
that a certificate has been
installed successfully. You will
need to close ALL Internet
Explorer windows in order for
the changes to take effect. You
should now have automatic
access to many of our secure
systems, including Success

Learning: AllianzU powered by Degreed

Factors and Allianz Connect.

Toward the end of your first week, you’ll have access to AllianzU powered by Degreed (our learning program)
to start your required courses. In addition to courses specific to Allianz Life, Degreed also gives you access to a
wide variety of educational resources designed to help you build your knowledge and skills. After logging in,
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you’ll be prompted to answer a series of questions and Degreed will create a personalized learning plan for
you.

Chrome is the preferred browser for accessing Degreed. Once you access Degreed, save it to your bookmarks or
favorites.

Through VPN —

e Use this SSO link http://eu.degreed.com/?orgsso=allianz
¢ Click OK when your global certificate appears

Through Citrix —

e Use this link https://eu.degreed.com/account/login
e Enter your Allianz email
e Select Log in using password and select Set/Reset password. Follow prompts to set password.

Via mobile device

You can also use your mobile device to tap into all of the training offered through 35 g:?;el_Zi;nin
Degreed. Search for the Degreed - Daily Learning Habit app in your app store. Habit ¥

Log in with your Allianz Life email and Degreed password. If you have not created a password yet, follow the
steps to create one (you will need access to your work email to complete the steps).

Explore:

We’ve curated pathways (collections of learning content) to help support you during this pandemic. Simply
choose whatever is relevant or interesting to you.

Follow a pathway that interests you or follow one of the skills in the plan to receive content in your feed
Set up your profile

Search for content that interests you

Click here for tips and FAQs

\

One of the Degreed courses you'll want to check out is Webex Resources (Allianz Life). This
course will give you a quick start on using Webex efficiently and effectively.

Given many of our interactions are facilitated with Webex, learning how to use the features it
offers will improve your experience and enable you to fully participate in meetings.

J
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Teleconferencing
Using a Conference Bridge

A conference bridge allows you to set up conference calls.

a. Dial the conference bridge phone number (631-267-4890).

b. Enter the meeting code or meeting number.

c. Enter the host code and PIN (host only).

Tips for using Webex

Webex is the approved tool for video conference meetings at Allianz Life. We have a lot of content on AllianzU
about how to use Webex effectively. Until you have access, here are a few tips to get you started:

¢ Review these Quick Tips from Webex to maximize the program’s effectiveness.
e Make sure you have a webcam so that people can see you.
¢ Always use a headset and not the built-in speakers so people can hear you clearly and to avoid

“feedback” from disrupting the meeting.
e Always mute when you’re not speaking.

Setting up Webex

A Webex account allows you to set up conference calls. It also includes a virtual meeting room with additional
functionality: screen sharing, doc and video sharing, chat, polls, etc. Ask your manager if he/she requested a
Webex account for you; and if not, determine with your manager whether you need your own account to set up
meetings. If you need to request one, do so through ServiceNow.

Use these instructions to set up your Webex
account.

1. Webex link: https://allianz-agn.webex.com
2. Click on My Webex tab.
3. Click on Preferences on navigation button

Page |24

Allianz ()

For technical support, call the Service Desk at 763.765.6181.

If you are still experiencing issues or delays, please then email Onboarding Support@allianzlife.com



mailto:Onboarding_Support@allianzlife.com
https://www.webex.com/content/dam/webex/eopi/assets/WebexMeetings_BestPractices.pdf
https://azlifeprod.service-now.com/nav_to.do?uri=%2Fcatalog_home.do%3Fsysparm_view%3Dcatalog_default
https://allianz-agn.webex.com/

4. Click on Audio Setup link.

= Preferences

» General

» "Meet Now" Settings

Video Systems

/1 » My Personal Room

5. Scroll down to Accounts and click
on the Generate account link.

NOTE: The option to generate

additional accounts will not appear /; A :
if you already have three bridges . N :

6. Click green Generate button to create the
additional audio bridge.

NOTE: You cannot set your own codes, they must
be system generated. Attendes

T e

7. Screen will update with your new host

and attendee audio bridge access codes. Add Personal Conference Number

Click on green Close button. R T

8. All your available personal audio bridge numbers are displayed on your preferences page.
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Requesting access to additional programs

This process is used once you're in your role and need additional access to do your job. Your manager
will help guide what requests you may need to submit.

How to make a request to add access
1. Go to the Security Access Request (Sailpoint) Home Page.

Click on the Service Portal OR Click on the Sailpoint 1Q App
App (Blue Pages) > Service (Blue Pages)

Catalog > Security and
Access > select Request
Security Access Go to Blue
Pages > Workplace Tools >
Applications and Websites
and click the “+” to add
Service Portal as a Favorite
Application. (so it will be on
your home page)

Go to Blue Pages >
Workplace Tools >
Applications and Websites
and click the “+” to add
Service Portal as a Favorite
Application. (so it will be on
your home page)

Service Portal Our one stop shop for Resource o Sailpoint (IlQ) - This is the tool to submit requests for +
Onboarding, the Service Catalog adding/removing access and the location
Tools and Tips, and more for manager approvals

2. From Home page, select Manage User Access.

A Home # &
Access Reviews > Approvals >
O O Manage User Access > Track My Requests >

3. Search for User(s) — You can also refine your search using the Filters function.

= Home My Work « ‘ Cindy (AZ.. ~

Select Users
Find and select users for whom you want to manage access.
Search User You can search by name or "user id/(AZL)" Y Filters v
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4. Once you’ve found the user(s), select by clicking ¥ Once selected, it turns green °

Users Sebocted: Cindy

° Cindy (AZL ']

Username: AZL
Manager: Adan

5. Click Manage Access, to select the access you need.

= Home  MyWork «
Manage User Access o
FSelect Users 2 Manage Access "2 Review and Submit
ind and select users for whom you want to manage access. Add access for the users you've selected. wd Lock
Add Access Remove Access
Search By Keywords v Search Access n Y Filters »
Find the access you are looking for by either:
Search By Keywords s Search Access n Y Filters &
9 Search By Keywords | - Search by word(s) in title (default view)
| & Find Users' Access - Allows you to look up an existing user and select an item(s) from their access.
& Filter Population - Allows you to look up the access a team has by filtering by a manager.

Or using the Filters dropdown. This allows you to search by: role, application, fileshare pathname, ....

Note: There are two types of access:
= Entitlement — individual access to something specific. Look at the descriptions for help in determining

which entitlement to choose.
= Role — bundled group of entitlements (previously known as a profile)

6. Select desired access by clicking .+ Once selected, it turns green o

o Custom OnBase query Premium Batches

Custom OnBase query Premium Batches

Type: Entitlement Application: OnBase Attribute: GROUP_NAMES
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Remember to consider your home network capacity and that of your current Internet service provider.
Here are some tips below that we suggest you consider when working from home.

Also, as a reminder, given our capacity/network constraints, DO NOT use corporate devices for high
band-width non-work activities (e.g., don’t stream Netflix on your corporate laptop...)

Activities that

speed

affect your internet

Every connected device in your home uses some of your internet speed.
Having many devices connected to your home Internet at the same time.
Doing multiple things that use a lot of Internet speed at the same time, like
streaming, gaming, video-conferencing, and downloading large files.
Connecting to Wi-Fi.

Using a wired connection tends to be faster.

How can | get the
most out of my
internet speed?

Restart your gateway on a regular basis.

Keep your gateway and devices away from obstructions (like metal) and
common sources of interference (like baby monitors and microwaves).
Move Wi-Fi devices closer to your gateway. The farther away they are, the
weaker the signal and the slower the speed.

Place your Wi-Fi gateway in a central location in your home or office.
Keeping it upright and off the floor improves coverage.

Only use Wi-Fi with devices that don’t have wired connection ports, like
smartphones, tablets, and home assistants. Use a wired connection for
other devices like PCs.

Add a Wi-Fi extender to improve coverage and signal strength, if needed.

What else affects

Interference from other Wi-Fi networks, especially in crowded areas or

conference calls

my internet buildings with high Wi-Fi use.

speed? Too many people connecting to a network, website, or app at once.
Connecting at peak hours.

If you have Start your meetings at 10 minutes after the hour or 10 minutes before the

difficulty hour to avoid the rush of calls into the system at the top of every hour.

connecting to Consider using your cell phone to add multiple calls. Here’s how:

Webex or o Call the first person.

o After the call connects, click the Add Call (+) icon.

o Call the next person (this will temporarily put your first person on
hold).

o When the second call connects, click the Merge icon to merge the
two calls.

o Repeat this for up to 5 participants.

o For more details on conference calls from your cell phone — Check
out this video for iPhone and this video for Android.
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Be Productive

Set aside a dedicated space (if possible) that you can separate from
your home life and leave at the end of the work-day.

Create your normal work routine at home, (e.g., set ground rules with
people in your space, keep calendar up to date).

Create a checklist of daily/weekly action items.

Remember that Webex and other communication tools do not have to be
used on the Allianz Life network. When the network is at high usage,
disconnect for meetings and non-business related computer use.

Stay Connected

Over communicate (e.g., what you are working on, your availability, key
priorities).

Support and hold each other accountable (e.g., recap actions, who’s
responsible, by when).

Host a “virtual watercooler” to maintain team connection (e.g., via email,
phone, Webex).

Continue regular 1-1s, whiteboards, team meetings — virtually.

“Show up” to meetings and be heard.

Keep work/life e Schedule breaks. Get up, stretch, take a walk.

balance e Eat lunch away from your work space.
e Create transition rituals to help “switch on” and “switch off.”
e Create a clear routine in the morning and evening, (e.g., walk around the

block), to signal your transitions.
Thank you! We hope your position at Allianz Life is full of
experiences that enrich your career and your life.
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